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Published as: Szulcek R, Bogaard HJ & van Nieuw Amerongen GP (2014). Electric Cell-substrate 

Impedance Sensing for the quantification of endothelial proliferation, barrier function, and 

motility, J Vis Exp (85), e51300, doi:10.3791/51300.

The presented immunofluorescence image was published as part of the ibidi calendar 2014 
and shows a confluent monolayer of human umbilical vein endothelial cells (HUVEC) cultured 
on the measurement electrode of the Electric Cell-substrate Impedance Sensing system (ECIS). 
The F-actin cytoskeleton was visualized with Rhodamine Phalloidin (red) and the nuclei with Hoechst 
(Blue). Reprint with permission. Copyright 2014 ibidi GmbH.
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ABSTRACT
Electric Cell-substrate Impedance Sensing (ECIS) is an in-vitro impedance measuring system to 

quantify the behavior of cells within adherent cell layers. To this end, cells are grown in special 

culture chambers on top of opposing, circular gold electrodes. A constant small alternating 

current is applied between the electrodes and the potential across is measured. The insulating 

properties of the cell membrane create a resistance towards the electrical current flow resulting 

in an increased electrical potential between the electrodes. Measuring cellular impedance in this 

manner allows the automated study of cell attachment, growth, morphology, function and motility. 

Although the ECIS measurement itself is straightforward and easy to learn, the underlying theory 

is complex and selection of the right settings and correct analysis and interpretation of the data is 

not self-evident. Yet, a clear protocol describing the individual steps from the experimental design 

to preparation, realization and analysis of the experiment is not available. In this article the basic 

measurement principle as well as possible applications, experimental considerations, advantages 

and limitations of the ECIS system are discussed. A guide is provided for the study of cell attachment, 

spreading and proliferation; quantification of cell behavior in a confluent layer, with regard to 

barrier function, cell motility, quality of cell-cell and cell-substrate adhesions; and quantification 

of wound healing and cellular responses to vasoactive stimuli. Representative results are discussed 

based on human microvascular (MVEC) and human umbilical vein endothelial cells (HUVEC), but are 

applicable to all adherent growing cells. 

The video component of this article can be found at http://www.jove.com/video/51300/.
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INTRODUCTION 
Here we present Electric Cell-substrate Impedance Sensing known as ECIS, a specific 
method to measure and analyze the impedance spectrum of adherent cells in culture 
(1). The aim of this protocol is to offer a generally applicable guide for the usage of this 
particular type of impedance based cellular assays and provide protocols for some of 
the key functions from the constantly growing number of applications. The focus will be 
on the study of cell proliferation, barrier function, cell junctions and cell motility.

Since ECIS and its associated model to transform the impedance spectroscopy data 
in biologically relevant parameters was introduced in its current form to the scientific 
community by Giaever and Keese in 1991 (2), it has often been referred to as a system 
for the measurement of TEER (trans-epithelial electrical resistance), which is not accurate. 
The differences seem marginal at first, but are important for the data interpretation. 
For classical TEER measurements, cells are grown on permeable filters to characterize 
para-cellular transport mechanisms, which are dominated by epithelial tight junctions 
or endothelial adherens junctions (3). Commonly, two electrodes positioned above and 
below the filter are used to apply a direct current (DC) flow over the cell layer and 
two other electrodes to measure the resulting voltage drop (4). The electrical resistance 
is calculated using Ohm’s law, which allows a numerical description of the quality of  
the cell barrier.

ECIS follows this basic principle and extends it. In the ECIS system, cells are grown 
on opposing, circular gold electrodes that are embedded in the bottom of special cell 
culture dishes. The number of electrodes per culture well is variable, dependent on 
the application and the electrodes have a standard diameter of 250 μm; in some cases 
a larger counter electrode is used to complete the circuit. ECIS uses a constant alternating 
current (AC) of 1 µA with a given frequency instead of a direct current. The impedance 
is calculated from the corresponding changes in voltage (in mV) between electrodes. 
ECIS offers the possibility to measure the impedance over a range of frequencies to 
study frequency dependent cellular properties, which has several advantages over TEER 
and will be explained in detail in this article. First, measuring complex impedance allows 
separating the overall impedance into cell barrier resistance and cell capacitance. In 
addition, by taking data at multiple frequencies and applying a mathematical model, 
one can differentiate between junctional impedance (tightness of cell-cell contacts) and 
impedance caused by cell-substrate interactions (distance of basal cell membrane to 
underlying matrix) as well as the contribution of the cell membrane capacitance. Second, 
cell proliferation and motility can be assessed, since the cells are in direct contact with 
the electrodes. Third, substrate and electrodes are sufficiently thin to allow for bright field 
and phase contrast microscopy.

Basis of impedance measurements: The complex impedance.
The basis for the measurement of the electrical impedance of biological objects (e.g. cells) 
is the Ohm’s law, a basic electro-technical principle, which describes the relation between 
resistance (R), current (I) and voltage (U) in an electrical circuit at a given time (t). 
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Applicable in DC circuit: 

R(t) = U(t)/I(t)

When working in the AC system, current and voltage not only differ in their amplitude, but 
also in their phase (φ). Now, resistance is no longer sufficient to describe these relations. 
Instead, the complex impedance (Z) or in most cases the magnitude of the impedance 
(|Z|) are used, containing the previously described ohmic resistance plus reactance (X), 
which results from AC flow through capacitors and inductors driving the phase shift 
between voltage and current (5). 

Applicable in AC circuit: 

|Z(f)| = Sqrt(R^2+X(f)^2)

φ = arctan(X/R)

When performing impedance measurements on intact cells, due to the characteristics 
of their membrane, cells act as a parallel connection of resistor and capacitor. Here, 
resistance represents the opposition to current flow, whereas capacitance (C) describes 
the separation of electric carriers at the insulating bi-layer of the cell membrane that 
causes polarization of the cell. Thereby X is dominated by the capacitive properties of 
the cell membrane. 

X(f) ≈ 1/(2*Pi*f*CCell)

Since X is frequency dependent, variation of the measurement frequency enables study of 
different functional and structural properties of the cell. The ECIS device measures both 
R and X, allowing for the calculation of |Z|, C and φ.

Quantifying entire cell layers with impedance spectroscopy:  
The electrical equivalent circuit.
As previously explained, when a cell is brought into an electrical field, it shows properties 
of passive electronic components. If now, instead of a single cell, an entire cell layer 
grown on top of electrodes and supplemented with cell culture medium is investigated, 
the simple model of resistor and capacitor needs to be extended to an entire electrical 
network. In this so-called equivalent circuit, resistance of the culture medium (RMed) as 
well as capacitance (CElectr) and resistance (RElectr) characterizing the electrode/electrolyte 
interaction need to be considered (3,6).
A simplified, general example of such an equivalent circuit for an adherent growing cell 
layer can be found in Figure 1. The advantage of such a mathematical approach to 
describe a biological system is that those circuits can be refined ad libitum and adjusted to 
the specific experimental questions, e.g. by considering impedance caused by intra-cellular 
organelles or to distinguish influences of cell-cell (RJunc) and cell-substrate adhesions (RSub) 
on overall impedance (7,8). Nevertheless, the aim for the modeling should always be to 
use the smallest number of elements describing all features of the measured impedance 
spectrum to allow meaningful correlations.



46 Chapter 2

Figure 1: Schematic of the ECIS system and representative equivalent circuit for an adherent 
growing cells layer. A) Cross section of an ECIS culture well. The cells are growing on top of 
sensing and counter electrode and are covered with culture medium. The electrodes are connected 
to a lock-in amplifier and an AC signal is applied via a 1 Mohm resistor to create a constant current 
source. Stimuli can be added directly to the culture medium at any point in time. B) ECIS measures 
the sum of all individual contributions to the impedance. Resistance of the culture medium (RMed) as 
well as impedance caused by the electrode/electrolyte interface, which is for simplicity presented as 
a parallel combination of a resistor (RElectr) and a capacitor (CElectr), and also the electrical properties 
of the cell membrane, described by a parallel connection of resistance (RCell) and capacitance (CMem), 
all need to be considered. RCell is variable, since it is dependent on the cell permeability towards 
the current. The equivalent circuit can be extended and refined ad libitum. As an example junctional 
(RJunc) as well as sub-endothelial (RSub) resistance were added to the circuit.

Impedance parameters and their biological meaning.
The two most direct parameters derived from impedance measurements are resistance 
and capacitance of cells. Resistance represents quality and function of the cell barrier and 
therefore takes into consideration the resistance towards para- and trans-cellular current 
flow. Capacitance provides an overall measure of electrode coverage. The distinctive 
feature of the ECIS is that with the help of equivalent circuits and modeling those global 
parameters provide insights on many more cellular properties, including cell-cell and cell-
substrate adhesions, which will be discussed later in this article.

Before starting: Experimental considerations.
Measurement setup - The setup consists of several separate components: ECIS device 

with measurement electronics; PC for data acquisition; array holder for the 8 or 96 well 

system; ECIS arrays and the cell culture of choice. The array holder must be placed in 
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an incubator and connected to the ECIS device outside the incubator. The PC needs to 
be equipped with the ECIS software (1.2.123.0 14th February 2013) and connected to 
the ECIS device.

Array selection - There is a continuously growing, variety of ECIS arrays, designed for 
multiple applications. The standard arrays are the 8W1E and the 8W10E arrays, which are 
composed of 8 culture wells (indicated by W) comprising 1 or 10 measurement electrodes 
(indicated by E), respectively. A large counter electrode completes the circuit, but its 
impedance is essentially negligible in the actual measurement (6). The standard 8 well 
array holder can host two arrays, resulting in a total number of 16 culture wells. The gold 
electrodes are 50 nm thick, delineated with an insulating film and mounted on either an 
optically clear Lexan polycarbonate substrate or a printed circuit board (PCB). The PCB 
arrays are more robust and cost efficient. The transparent slides allow for light and 
immunofluorescence microscopy. What must be considered is that the 1E array enhances 
fluctuations in the resistance signal caused by cell motions and is needed for wound 
healing studies. In addition, single electrodes allow correlation of electrical and optical 
signals. In the multi electrode arrays, the signal is averaged over several electrodes, which 
due to the increased measurement area includes more cells in the measurement, limits 
bias of the data by uneven inoculation and growth of the cells and reduces blurring of 
the signal due to cell motions. Therefore, the multi electrode arrays are useful to study 
cell proliferation and barrier formation. Next to standard arrays, there are special arrays 
available for the application of shear stress (9), to study chemotaxis (10), cell migration 
and proliferation as well as 96 well-plates for high throughput screenings. To conclude, 
the array to be used is strongly dependent on scientific question and cell type and should 
be selected and tested carefully. 

Measurement frequency - The modeling of Rb and Alpha (see data analysis) requires 
multi frequency measurements (MFT). Otherwise impedance can be measured over time at 
one cell type specific frequency (SFT), with the advantage that data can be collected with 
a higher temporal resolution. The most sensitive measurement frequency for a specific cell 
type can be found by frequency scans. When plotting impedance respectively resistance 
vs. frequency in a log-log graph the frequency where the difference between cell-free 
and cell-covered electrode is biggest is the frequency where the cells block the current 
most effectively. In case of endothelial cells (EC) this frequency is at about 4 kHz.

Seeding density - As in every regular cell-based experiment seeding density depends 
on the scientific problem. When studying adhesion and spreading or barrier formation, 
endothelial cells should be seeded with a high density of 40,000 to 60,000 cells/cm2 to 
guarantee a confluent, stable barrier after 48 hours. If the focus of the experiment is on 
proliferation, EC should be seeded with a low density of about 2,000 to 10,000 cells/cm2.

Protocol
1. Preparation of measurement system

1.1 Pre-warm the array holder in an incubator to 37 °C before starting the experiment 
to prevent condensation.
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1.2 Fill water casket of the incubator with distilled water to avoid drying of the wells. 

1.3 Perform all manipulations on cells and arrays in a laminar flow cabinet under  

sterile conditions. 

2. Preparation of arrays and inoculation of cells 

NOTE: The ECIS arrays need to be cleaned and stabilized before an experiment to 

prevent electrode drift, to improve well-to-well reproducibility and signal-to-noise 

ratio. Therefore two options are available: A) pretreatment of the electrodes with 

L-cysteine and B) the stabilization function of the ECIS. 

Option A: L-cysteine is recommended as the most consistent pre-treatment, but 

might in some special cases interact with protein coatings on the electrodes. 

The volumes presented are used for standard 8 well arrays.

2.1 Add 200 µL/well 10 mM L-Cysteine. Cysteine cleans and modifies the electrode 

surface providing a high and reproducible electrode capacitance.

2.2 Incubate 15 min at room temperature (RT).

2.3 Wash 2x 500 µL/well with ultra-pure water (type 1). Don’t use phosphate 

buffers, which can interfere with the adsorption of some proteins. Also avoid 

serum-containing solutions before coating, since the gold surface will adsorb 

the first macromolecules brought in contact.

2.4 Coat with 200 µL/well warm 1% gelatin. 

2.5 Incubate 30 min at 37 °C.

2.6 Remove gelatin, but don’t let surface dry. This can damage the electrodes.

2.7 Wash 1x with ultra-pure water (type 1).

2.8 Add 400 µL/well complete cell culture medium (containing serum, antibiotics 

and all growth factors).

2.9 Slide array into array holder and make sure that the array is positioned such 

that the nine gold square pads are properly contacted by the spring-loaded 

pogo pins and fix adjustment screw hand tight. Be careful with transparent 

arrays, the gold layer can easily be damaged.

2.10 Open the measurement software and press Setup followed by Check in  

 the “Collect Data” section to perform a quick impedance measurement of  

 each individual well at the default frequency of 4000 Hz. The resulting  

 values are the measurement baseline and will automatically be stored  

 in the “Comments”. 

2.11 The well check will automatically determine the type of ECIS arrays used.  

 Verify the selected arrays in the “Well Configuration” section. 
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2.12 The array diagram lights up green for properly connected wells and red for  
 empty or incorrect connected wells. Still, always make sure that the arrays  
 were placed correctly in the holder.

NOTE: If cleaning and coating were successful, the 8W1E ECIS arrays have 
a capacitance of about 5-6 nF and the 8W10E arrays of 50-60 nF, which 
results in a baseline resistance of about 2,000 respectively 200 ohms before 
cell seeding.
NOTE: If modeling of the data (Rb, Alpha and Cm) will be required, start 
a MFT recording (see point 3) with the medium filled array. Take 15 minutes 
of cell-free data, and Pause the experiment to add the cells.

2.13 Remove array from holder.

2.14 Seed cells as a single cell suspension in 400 µL/well complete cell  
 culture medium.

Option B: The stabilization function of the ECIS can be used as an alternative or in 
combination with the L-cysteine treatment and if problems with electrode drift or 
large differences in well-to-well resistance and capacitance occur.

2.15 Perform cysteine treatment (optional) and pre-coat electrodes with  
 protein (optional).

2.16 Add 200 µL/well of complete medium to each well and place the array in  
 the array holder. 

2.17 Open measurement software and press Setup followed by Check to ascertain  
 the array is properly connected and to measure initial Z, R and C.

2.18 Stabilize the electrodes by pressing Stabilize in the “Collect Data” section.  
 The ECIS will apply a high current (ca. 3 mA), high frequency (64 kHz) pulse  
 to clean the electrodes.

2.19  Check electrodes again. Capacitance should be increased and resistance values  
 should be in a comparable range.

2.20 If capacitance and resistance values are still not satisfactory, repeat  
 the stabilization. 

2.21 Remove array from the holder and inoculate cells.

3. Setting up measurement software and data acquisition

3.1 Place the array in the array holder as described before.

3.2 Open measurement software and press the Setup button in the “Collect Data” 
section to connect the ECIS software to the ECIS instrument and run another 
well Check.

3.3 Verify the selected arrays in the “Well Configuration” section.
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3.4 Select the wells to be measured in the “Well Configuration” section. 

3.5 Select the measurement mode from the “Collect Data” options:

3.5.1 For a time series at a fixed frequency, select Single Freq. / Time (SFT) 
and choose the measurement frequency from the drop down menu.

3.5.2 For measurement of electrode coverage and modeling of Rb and Alpha, 
select Multiple Freq. / Time (MFT). The ECIS device will measure 
automatically at all available frequencies. 

3.5.3 For micromotion (see data analysis) select Rapid Time Collect (RTC) 
and adjust measurement frequency and sampling frequency. Here 
the standard temporal resolution is one sample per second (1 Hz), but 
sampling frequency can also be increased to track fast changes in 
impedance up to 25 Hz (for the Z-Theta). Important note: in RTC mode 
only a single well is measured at the time. 
NOTE: If micromotion need to be measured in several wells subsequently, 
go to Help –> Show expert toolbar/menu items –> Acquire –> Multi-Well 
RTC. Specify the Time limit (hrs) in the “Collect Data” section; the ECIS 
will now measure the selected wells in numerical order. After starting 
the measurement the software will ask to specify the numbers of cycles. 
Enter the value for how often the measurement needs to be repeated.

3.6 For SFT and MFT, select the time Interval (sec) between measurements or if 
data need to be acquired as fast as possible leave this option unchecked.
NOTE: To acquire data the ECIS device uses a multiplexer to switch from one 
well to another with a minimum SFT acquisition rate of 0.25 sec and 7.5 sec 
for MFT. Meaning the interval is dependent on number of selected wells and 
frequencies. For measurements on slow proliferating cells or a simple recording 
of resistance vs. time, use intervals of 600 sec or more. 

3.7 Press Start, name the file and select location to store the data.
NOTE: File size should not be a problem, since ECIS data are saved in a kind 
of plain text format called *.abp, which never exceeds some hundred MB even 
with all measurement frequencies and number of wells selected.

3.8 Stop run by pressing Finish.

4. Medium change and cell manipulation

4.1 Press Pause, this will stop the data acquisition, but continue to run  
the experimental clock. 

4.2 Remove the array from the holder and manipulate it under a laminar flow 
bench (i.e. change medium). 
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4.3 Place array back in the holder and click Check Connection to verify electrical 
connection and then Resume Experiment to continue data acquisition. 
The measurement software will place a time mark in the data set.

5. Acute stimulation during data acquisition
NOTE: A second option is to manipulate the cells during data acquisition to follow 
immediate changes. This is only possible, when samples don’t needs to be sterile in 
the further course of the experiment.

5.1 Add the stimulus directly to the well and make sure to mix careful with  
a 200 µL pipette.  

5.2 Mark time point manually by pressing Mark and add a comment.

6. Electrical wounding 
NOTE: Finding the right settings for the used cell type is key for electrical wounding. 
If wounding is too short this can result in insufficient removal of cells, whereas if 
wounding is too long and/or rough this can damage the electrodes (especially on 
the transparent arrays). Therefore, several short wounding pulses are recommended. 
For HUVEC cultures two 10 to 20 sec long wounding pulses of 5 V at 60 kHz each 
have been found optimal using the ECIS 1600R. In general it is recommended to 
use high frequencies >20 kHz to maintain uniform high fields across the cells and 
to avoid any damage to the electrodes.

6.1 Perform wounding during an active ECIS measurement.

6.2 Enable Wound / Electroporate Setup, then click Wound and fill in the time 
(sec), wound voltage (V for 1600 R) or current (μA for Z and Z-Theta) and 
frequency (Hz). The displayed default values are based on the type of array and 
ECIS device. 

6.3 Select the wells to wound in the “Well Configuration” section. Only the checked 
wells will be wounded.

6.4 Enable Delay Until Hour and fill in the delay time to activate the delay wound 
function. This function can be stopped at any time by pressing Stop or applying 
a wound manually. Only one delay command can be active at a time.

6.5 Press Activate and click OK in the pop-up window to start wounding.

6.6 Make sure that the signal drops to a value of an almost cell-free electrode, 
otherwise repeat the wounding. 

7. Data analysis

7.1 Data representation and exporting.

7.1.1 Finish measurement or load data set via File -> Open.
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7.1.2 Select wells to be displayed from the “Well Configuration” window. 
Group individual wells to present the average.

7.1.3 Chose parameter to be displayed from the upper toolbar (Z, R or C).

7.1.4 Select graph type from the upper toolbar (T = time, F = frequency,  
3D = waterfall blot).

7.1.5 Define graph offset and range with the sliders below the graph window 
or fill in the exact values in the adjacent controls.

7.1.6 Chose from the basic “Time-Series Options” in the “Analyze” section 
to perform standard deviation, running average or normalization of 
the data.

7.1.7 Activate Expert Toolbar in the Help menu for more advanced operations 
like Nyuist plot and Fourier transformation. 

7.1.8 Use “Display Options” in the “Analyze” section to define range of x- and 
y-axes and export graph. 

7.1.9 Export selected data to an Excel file via File -> Export Data -> To Excel 
(Selected) and use a third party software of choice for in depth analysis, 
statistics and representation as needed. 

7.2 Modeling of Rb and Alpha
NOTE: For modeling it is recommended to use a cell-free, medium filled well  
as reference. 

7.2.1 Finish MFT measurement or load MFT data set.

7.2.2 If a cell-free reference well is available press either Find to automatically 
select the reference value or Set to select the cell-free time point manually 
from “Freq. Scan Modeling” in the “Analyzing” section.

7.2.3 If there is no cell-free reference, import a reference value from another 
data set. Open the reference data set (make sure that the same array 
and medium was used) and use Find or Set to select the reference value. 
Then navigate to the measured data and press Get.

7.2.4 If there is no cell-free reference data set available use the factory default.

7.2.5 Press Model to start the calculations. Modeling might take several 
minutes dependent on the size of the data set.

7.3 Calculation of micromotion
NOTE: This calculation is not part of the measurement software, but can be 
performed with any signal processing software. 

7.3.1 Finish RTC measurement or load RTC data set.

7.3.2 Normalize data set by the averaged resistance of the entire period.
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7.3.3 Break data set into segments with a length of 256-data points and clean 

each segment by a Hanning window.

7.3.4 Run a 256-point Fourier transformation and average resulting frequency 

spectra to a single-sided 129-point power spectrum to minimize random 

noise and enhanced the biological signal.

7.3.5 Plot frequency against amplitude in a log-log graph and apply least 

square linear fit. 

7.3.6 The slope of the linear fit is a measure of overall noise in the signal and 

thereby micromotion of the cells. Alternatively, the area under the curve 

(AUC) can be quantified, but is generally not used in published literature.

REPRESENTATIVE RESULTS
Setting up an experiment is fairly simple and the measurement itself is fully automatic, 

but as is often the case, correct analysis and interpretation of the data are crucial. In 

this representative data section a guide is provided for the interpretation of the most 

important parameters provided by impedance spectroscopy with ECIS. This will be helpful 

to decide for which kind of scientific problem an ECIS measurement can be useful and 

which parameters should be recorded.

A typical experimental read-out can generally be divided in a growth-phase after cell 

inoculation and a plateau-phase when cells reach confluence. Each of these phases yields 

information on different cellular properties. A representative measurement is shown in 

Figure 2 and divided into four sub-phases to analyze A) cell adhesion, spreading and 

proliferation; B) formation of a maturation EC barrier; C) cell migration after the generation 

of an electrical wound; and D) the cellular response to stimulation with the vasoactive 

agent thrombin. Phase-contrast and immunofluorescence images were acquired directly 

from the measurement electrode during the different sub-phases to illustrate the link 

between electrode coverage, cell status and recorded impedance signal.

Adhesion, spreading and proliferation
Every cell type has its characteristic adhesion and growth curve that can be manipulated 

by varying seeding density, coating with extracellular matrix proteins or other stimuli. One 

of the major difficulties to study those processes is to differentiate between adhesion, 

spreading and proliferation. Wegener et al. (11) gave a detailed description for the use 

of a combination of resistance and capacitance to distinguish between those parameters 

and in Figure 3 it becomes obvious how resistance and capacitance can complement each 

other. 

It is important for the study of adhesion and spreading to understand the influence 

of the measurement frequency, because here the electrical field causes a polarization 

of the cell membrane of the cells in suspension (8), which forces the current to flow 

exclusively around the cells. When the cells attach, they start to restrict the current 
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flow by spreading over the electrode and capacitance decreases in a linear fashion 
with the percentage of open area on the electrode (fractional area). Hence, adhesion, 
spreading and proliferation can be quantified best, when recording capacitance at 
a frequency higher than 40 kHz (Figure 3, B), where the decrease in capacitance is directly 
proportional to the electrode coverage. Alternatively, resistance at its most sensitive 
measurement frequency is a direct measure for the differentiation and maturation of 
cells into a confluent barrier (Figure 3, A). In addition to the fractional area, Wegener et al. 
introduced two other parameters to quantify adhesion and electrode coverage: t1/2 (half 
maximum capacitance), which is the time until 50% of the electrode is covered with cells 

Figure 2: Representative measurement. Microvascular endothelial cells (MVEC) were grown on 
a gelatin coated 8W1E arrays with a low seeding density of 5,000 cells/cm2 and MFT recording was 
performed over 10 days. The measurement illustrates the different read-outs of an ECIS experiment: 
A) adhesion, spreading and proliferation; B) formation and maturation of a confluent cell barrier; C) 
wound healing after the application of an electrical wound; D) stimulation with the vasoactive agent 
thrombin. The two arrows indicate medium refreshments, which were performed in intervals of 4 
days and give an idea about the sensitivity of the measurements towards mechanical stimuli and 
changes in temperature and pH. The images in the top panel correspond to the measurement and 
were acquired directly from the measurement electrode. The phase-contrast image on the left shows 
the endothelial cells 24 hrs after inoculation, starting to cover the electrode. The immunofluorescence 
pictures in the center and on the right present F-actin staining of the confluent endothelial layer 
before and after stimulation with thrombin (1 U/mL). Thrombin causes contraction of endothelial 
cells by formation of so called stress fibers and the transient opening of inter-endothelial gaps 
(arrows and image inserts), which are recognizable in the ECIS signal by a drop in resistance to 
baseline. Here, the sensitivity of the measurement becomes obvious and how changes in the cell 
layer correlate with the impedance signal. 
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(Figure 3, B, insertion), and the slope of the capacitance curve (not shown) as the rate of 

cell spreading and proliferation. 

Resistance as a measure of barrier quality
Resistance is the part of impedance that describes barrier quality and function best, 

because it neglects capacitive components from membrane, electrode and medium. Here 

the term barrier quality and not permeability is used, since permeability is per definition 

only dependent on cell-cell contacts. Resistance, however, is determined by the ability of 

cells and their cell-cell and cell-matrix interactions to block the current flow. Accordingly, 

Figure 3: Cell attachment and growth. MVEC from the same donor were seeded with three 
different densities on gelatin coated 8W10E arrays and cell growth was recorded at multiple 
frequencies for 60 hrs. A) Resistance values for the three conditions at their optimal frequency 
of 4 kHz to measure barrier formation. All three seeding densities established a confluent barrier 
of ca. 1200 ohm at the end of the measurement. The proliferation rates (slopes of the curves), 
however, differ markedly. B) Measurement of capacitance at 64 kHz provides insights on adhesion 
and spreading. Adhesion is the initial plateau phase in the capacitance curve (between 2 and 8 
hrs). Spreading, which is in linear relation to the electrode coverage, is represented by the slope of 
the curve and is completed after 10 - 30 hrs depending on the seeding density. The time point t1/2 
(half maximal coverage) can be used for statistical analysis. 
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different cell types (clones and passages) have their specific resistance values (Figure 4, A). 
Although resistance gives a much clearer idea about the cell barrier, the impedance signal 
should always be taken into consideration.

Modeling of Rb and Alpha
The ECIS software harbors a particular feature, the ability to model two parameters, 
which distinguish between cell-cell and cell-matrix adhesions (Figure 4, B and C). Rb 
(in cm2 x ohm), is the resistivity of cell-cell contacts to the current flow and thereby 
an inverse measure of classical permeability. High Rb implies low permeability towards 
the current flow. Alpha (in cm x ohm0.5), is a measure for the impedance contributions 
arising from the cell-electrode junctions. The model to quantify cell-cell and cell-matrix 
contacts was introduced 1991 by Giaever and Keese and is based on the assumption 
that cells are circular, disc shaped objects that have an insulating membrane, hover over 
the electrode and are filled with conducting electrolyte (2). The insulating property of 
the cell membrane leaves only three pathways for the current: a) between ventral surface 
of the cells and electrode, b) between the cell-cell contacts, and c) through the cells 
(only likely when a high measurement frequency is used). A more detailed derivation and 
explanation can be found in the papers of Lo et al. (3,12). 

Micromotion
It has been shown that small fluctuations in the resistance signal (Figure 4, A) are due to 
subtle, random cell movements in confluent cell layers as well as cells moving on and off 
the electrode in sparse cultures (2). This aspect of ECIS time-course data described by Lo 
and Opp et al. (13,14) is often overlooked and best seen when measuring with the 1E 
arrays and at the most sensitive frequency to account for para- and sub-cellular current 
paths. The calculation of this cell caused noise (micromotion) is not part of the standard 
measurement software, although in the newest version Fast Fourier Transformation 
(FFT) is integrated. Recording RTC data with a sampling frequency of 1 Hz for one 
hour at 4 kHz provides sufficient resolution for the calculation of EC micromotion. This 
calculation provides one single value and can be directly used for statistical analysis. An 
extended discussion on the use of frequency analysis for micromotion can be found 
elsewhere (15). Alternatively, to FFT other analysis strategies can be used, like variance 
of the increments. Variance is more sensitive towards small changes in micromotion, but 
because of this sensitivity the comparison of individual experiments becomes difficult. 
The slopes of the power spectrum are a more robust measurement of micromotion 
(Figure 4, D). Here the AUC can be seen as the amount of micromotion or noise the cells 
create. Hence, the steeper the slope of the power spectrum the smaller the AUC and  
the smaller the micromotion.

Electric wound healing assay 
To study migration of cells, usually mechanical wounds are applied by scratching cells off 
the culture plate with pipette tips, cell scrapers or specific stamps and follow their re-
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migration microscopically (16). This method has the obvious disadvantage that the size 
of the scratch varies and is usually too big to neglect the influence of cell proliferation 
on the wound healing process. The wounding function of the ECIS uses a high voltage, 
high frequency pulse to get a cell free electrode and subsequently follows re-migration of 
neighboring cells to replace the dead cells (Figure 5, A). An advantage of this automated 
method over standard, labor intensive scratch assays is that the ECIS produces a highly 
reproducible wound with a precise diameter of 250 µm that closes within a few hours, 
to study pure migration. Further, the electrical pulse does not remove protein coating 
and secreted extracellular matrix. Under the assumption that the cells re-migrate on 
the electrode from all sides, the migration rate can easily be calculated by dividing 
wound radius by time required for wound closure (17). As an alternative to electrical 
wounding, recently the so-called electric fence method was introduced (not shown). Here 

Figure 4: Characterization of the confluent barrier. Two MVEC donors with different passage 
numbers (passage 3 and 6) were seeded on gelatin coated 8W1E arrays and a MFT measurement 
was performed for 30 hrs to characterize the EC barrier. A) Resistance measurements reveal that 
the younger donor 1 has a higher resistance of ca. 11,000 ohm in comparison to the ca. 7500 
ohm of the older donor 2. B-C) The modeling capabilities of the ECIS have been used to find 
the cause for the lower resistance. Modeling revealed a comparable cell-cell interaction Rb and 
indicated a weakened cell-matrix interaction Alpha as a possible cause. D) RTC was performed 
to quantify micromotion within the confluent cell layer by Fourier transformation, where the area 
under the curve is proportional to micromotion. Analyses of the spectra shows less micromotion 
of the older donor 2 and thereby support what can already be assumed from the resistance signal 
(less variance). 
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high current pulses prevent attachment and migration of cells on the electrodes after 
inoculation. The cells will grow around the measurement electrode and start migrating 
inwards as soon as the electric pulses are turned off. The advantage of the electric fence 
over the electric wounding is that the electrode surface hasn’t been altered by cell growth 
or cell removal, which is important to measure the influences of different coatings on  
cell migration.

Cell stimulation
In addition to the study of cell migration, impedance spectroscopy is perfectly suited 
to measure the effects of drugs and toxins on cells. Figure 5, B presents a classical 
stimulation/inhibition experiment, where thrombin was used to induce hyper-permeability 
in the confluent EC barrier by contraction and gap formation of cells, which manifests 
as a transient drop in resistance. By pre-incubation with the Rho kinase inhibitor 
Y-27632 most of the thrombin response is diminished by lowering basal cell tension 
(18) and blocking stress fiber formation (19). Then the Rho kinase blocker was used 
at different time points after thrombin addition, leading to an immediate and total 
recovery of the EC barrier. Here the advantage of a continuous impedance measurement 

Figure 5: Cell migration after electric wounding and effects of thrombin stimulation. 
Impedance recordings were performed at 4 kHz with maximal temporal resolution. A) MVEC donor 
1 was used in passage 3 and donor 2 in passage 6 on gelatin coated 8W1E arrays and grown to 
confluence. Then an electrical wound was created by application of two 5 V pulses at 60 kHz with 
a duration of 20 sec each. The younger donor 1 showed better wound healing capabilities based 
on a faster wound closure (migration, slopes of the curves) and a higher resistance after wounding 
in comparison to the older donor 2. B) Human umbilical vein endothelial cells (HUVEC) were grown 
on gelatin coated 8W10E arrays. Upon confluence the cells have been serum starved for 1.5 hrs by 
replacing the complete culture medium with basal medium plus 1% human serum albumin (HSA). 
Usage of plain medium with HSA is a critical step, since serum components block the thrombin 
response. As soon as a stable resistance plateau was detected, thrombin was added directly to 
the wells and mixed carefully with a 200 µL pipette. The maximal thrombin effect is visible after 30 
min, characterized by a transient drop in resistance to baseline and a ca. 30-50% lower resistance 
after recovery. The cells were either pre-incubated with the Rho kinase blocker Y-27632 for 30 min 
or the blocker was added 20, 30 or 40 min after thrombin addition, which diminished the thrombin 
effect immediately. 
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system to study acute cellular responses becomes obvious. In regular endpoint assays  
(e.g. immunofluorescence staining or macromolecule passage), this acute response to 
the used blocker would be very difficult if not impossible to detect and quantify. Important 
to note is that with impedance measurements the permeability towards ions is described 
and not towards macromolecules. Please refer to Aman et al. (20), where an excellent 
comparison between ECIS measurements and macromolecule passage experiments  
is provided. 

DISCUSSION 
ECIS is an excellent tool for the screening of cell properties and behavior as well as for 
the quantification of the effects of known and unknown substances. Thereby the cells 
are held under standard culture conditions, impedance can continuously be monitored 
with a high temporal resolution and correlated to optical signals. That way the optimal 
time point for cell manipulations can be chosen on the basis of the morphological and 
functional cell status. Unfortunately, this high measurement resolution comes with 
the price that small changes in temperature, pH or mechanical stimulation of cells 
(medium change) will influence the impedance signal immediately.

The application of the small measurement current to the cells makes the ECIS 
measurement non-invasive, non-destructive and label-free, but as a result only passive 
bioelectrical properties can be measured (no action potentials). A key feature is that 
a number of parameters can be derived from a single measurement, combining 
the information from several classical assays, like permeability or wound healing assays. 
Here the particular interesting aspect is that mathematically modeled data can be used to 
explore changes in resistance and capacitance and refer them to distinct cellular structures 
(e.g. cell-contacts or cell membrane). Important to note is that impedance spectroscopy 
always provides an averaged signal from all cells on the sensing electrode, which does not 
allow for studies on single cells and also the mathematical model is only valid in confluent 
cell layers. Therefore, endothelial cells should be held in the confluent state for at least 
one day before used for modeling to ensure mature cell-adhesions and quiescent cells. 
Equally, electrical wounds should only be applied to confluent cell layers using multiple 
short wounding pulses with high frequencies, to achieve optimal wounding efficiency 
and prevent damage of the electrodes. 

To get the maximal amount of information from an ECIS measurement, as in every 
assay, several parameters such as the combination of array substrate, coating and seeding 
density for the individual cell type need to be tested and optimized before an experiment. 

A major limitation of ECIS is that the measurement does not provide direct 
information on the molecular level. Thus ECIS measurements are usually most informative 
at the beginning of an experimental series to help associate a scientific problem with 
cellular structures or properties and provide significant input for the generation of 
a testable hypothesis. Therefore, the modular design of ECIS provides a wide spectrum 
of applications with the possibility for tailor made arrays. The latest array developments 
indicate a future focus on high throughput impedance screenings for cell proliferation 
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and electrical wounding and the advance of special flow arrays for the simulation of 
in-vivo like shear stresses with different flow profiles.

ACKNOWLEDGMENTS
The authors would like to thank Dr. Charles Keese, Dr. Christian Renken  
(Applied BioPhysics Inc.) and Dr. Ulf Rädler (ibidi GmbH) for their advice, help and 
the fruitful discussions during the preparation of this manuscript. Further we would like 
to thank Jan van Bezu for his excellent technical support. This research was conducted 
with support from the Dutch Lung Foundation (Longfonds), Grant number 33.12.036.

DISCLOSURES
Applied BioPhysics Inc. covered the open access fees, whereas structure and content of 
the article remained full responsibility of the authors.



Electric Cell-substrate Impedance Sensing 61

2

REFERENCES 
1. Giaever, I. & Keese, C. R. A morphological 

biosensor for mammalian cells.  
Nature 366 (6455), 591–592 (1993).

2. Giaever, I. & Keese, C. R. Micromotion of 
mammalian cells measured electrically. Proc. Natl. 
Acad. Sci. U.S.A. 88 (17), 7896–7900 (1991).

3. Lo, C. M., Keese, C. R. & Giaever, I. Cell-
substrate contact: another factor may 
influence transepithelial electrical resistance 
of cell layers cultured on permeable filters. 
Exp. Cell Res. 250 (2), 576–580 (1999).

4. Wegener, J., Sieber, M. & Galla, H. J. 
Impedance analysis of epithelial and 
endothelial cell monolayers cultured 
on gold surfaces. J. Biochem. Biophys. 
Methods 32 (3), 151–170 (1996).

5. Pänke, O., Balkenhohl, T., Kafka, J., Schäfer, 
D. & Lisdat, F. Impedance spectroscopy 
and biosensing. Adv. Biochem. Eng.  
Biotechnol. 109 (11/2007), 195–237 (2008).

6. Wegener, J., Zink, S., Rösen, P. & Galla, 
H. Use of electrochemical impedance 
measurements to monitor beta-adrenergic 
stimulation of bovine aortic endothelial cells. 
Pflugers Arch. 437 (6), 925–934 (1999).

7. Eker, B., Meissner, R., Bertsch, A., Mehta, K. 
& Renaud, P. Label-free recognition of drug 
resistance via impedimetric screening of breast 
cancer cells. PloS ONE 8 (3), e57423 (2013).

8. Nacke, T., Anhalt, M., Frense, D. & Beckmann, 
D. Anwendungsmöglichkeiten der 
Impedanzspektroskopie in der Biotechnologie 
(Application of the Impedance Spectroscopy 
in the Biotechnology). tm - Technisches 
Messen 69 (1/2002), 12-18 (2002).

9. DePaola, et al. Electrical impedance of 
cultured endothelium under fluid flow. 
Ann. Biomed. Eng. 29 (8), 648–656 (2001).

10. Pietrosimone, K. M., Yin, X., Knecht, D. A. & 
Lynes, M. A. Measurement of cellular chemotaxis 
with ECIS/Taxis. J. Vis. Exp. (62), (2012).

11. Wegener, J., Keese, C. R. & Giaever, I. Electric 
cell-substrate impedance sensing (ECIS) as 

a noninvasive means to monitor the kinetics 
of cell spreading to artificial surfaces. Exp. 
Cell Res. 259 (1), 158–166 (2000).

12. Lo, C. M., Keese, C. R. & Giaever, I. 
Impedance analysis of MDCK cells measured 
by electric cell-substrate impedance sensing. 
Biophys. J. 69 (6), 2800–2807 (1995).

13. Lo, C. M., Keese, C. R. & Giaever, I. Monitoring 
motion of confluent cells in tissue culture. 
Exp. Cell Res. 204 (1), 102–109 (1993).

14. Opp, D., Wafula, B., Lim, J., Huang, E., Lo, J. 
C. & Lo, C. M. Use of electric cell-substrate 
impedance sensing to assess in vitro cytotoxicity. 
Biosens. Bioelectron. 24 (8), 2625–2629 (2009).

15. Szulcek, R., Beckers, C. M. L., et al. Localized 
RhoA GTPase activity regulates dynamics of 
endothelial monolayer integrity. Cardiovasc. 
Res. 99 (3), 471–482 (2013).

16. Liang, C.-C., Park, A. Y. & Guan, J.-L. In vitro 
scratch assay: a convenient and inexpensive 
method for analysis of cell migration in vitro. 
Nat. Protoc. 2 (2), 329–333 (2007).

17. Keese, C. R., Wegener, J., Walker, S. R. & 
Giaever, I. Electrical wound-healing assay 
for cells in vitro. Proc. Natl. Acad. Sci.  
U.S.A. 101 (6), 1554–1559 (2004).

18. Krishnan, R., Klumpers, D. D., et 
al. Substrate stiffening promotes 
endothelial monolayer disruption through 
enhanced physical forces. Am. J. Physiol.,  
Cell Physiol. 300 (1), 146–154 (2011).

19. Van Nieuw Amerongen, G. P., van Delft, 
S., Vermeer, M. a, Collard, J. G. & van 
Hinsbergh, V. W. Activation of RhoA by 
thrombin in endothelial hyperpermeability: 
role of Rho kinase and protein tyrosine 
kinases. Circ. Res. 87 (4), 335–340 (2000). 

20. Aman, J., et al. Effective treatment 
of edema and endothelial 
barrier dysfunction with imatinib.  
Circulation 126 (23), 2728–2738 (2012). 

FURTHER LITERATURE
Please also refer to the website of Applied BioPhysics (www.biophysics.com) for application 
notes, webinars and a detailed list of publications covering the entire ECIS spectrum.


